Camtasia is a video capture software used to capture a computer screen and/or webcam, along with voice capture. Some common uses are; software tutorials, process explanation, website tours, and narrated PowerPoint presentations.

**Camtasia**

When Camtasia is initially opened, the Camtasia welcome screen appears. This splash screen will appear every time you launch Camtasia unless the “show this dialog at startup” option is deselected, which is located on the bottom left side of the Window.

From the welcome screen users can;
- Record the Screen, which will start allow the screen to be captured and will start a new project.
- Select Import Media to import images, sound files, etc. that can be included in a video
- Open an existing Camtasia project
The Camtasia Editor
If the Welcome screen is closed, or disabled, the Camtasia Editor screen will appear, where users are able to Record the screen, import media, or Produce and share a video.

After a recording has been created, Camtasia will open the Editor where the video can be previewed and edited. Here is a quick overview of the pieces of the Editor.

Clip Bin
This is where all items in your project will be located. Items can be your recording, audio, photos, etc. There are several tabs, some are located by clicking on the More tab, located in the Clip Bin area. We will cover several of these later on.

Canvas
The canvas is where the recorded video is previewed. The preview will show any special effects that have been added to the video. The video can be resized and rotated from here as well.

Timeline
This is where you assemble and edit your video. There are an unlimited number of tracks that can be added to your video. You are able to layer items, animations, pictures, audio, etc. on your video via tracks. (These work like layers do in Photoshop)
**Record a Video**

To record, click on the Record the screen button on the top left of the screen.

**Note:** Everyone is different when it comes to recording a training or how to video. Some people type out every word they want to say in a script, while others just keep it simple and talk while recording.

**Tip:** If you type up your narration, you can use it as part of your captioning. Captioning keeps you in line with the 508 Disabilities Act.

**Recording Dimensions**

The first time you create a video, Camtasia will be set to record the ‘Full Screen’. There will be a green line on your screen that will show you what will be recorded. You can override this by clicking on the Custom button dropdown menu in the Recording toolbar.

From the Custom dropdown, you are able to select from preset dimensions pertaining to Widescreen or Standard screen dimensions. As you select different dimensions, you will see green dashed lines of what will be recorded.

**Tip:** Typically you will want to record in the largest dimensions to capture as much of the screen as possible.

There is also a Lock to application option. This will ensure that the application you are recording will be the only part of your screen that is recorded. If you select the “Lock to application” option, Camtasia will lock the recording area around a particular application. When this option is selected, you are still able to select the dimensions that you want and Camtasia will adjust the application to fit those dimensions.

**Tip:** Make sure the application that you want to record is the last application that you used before changing the recording dimensions and selecting the Lock to application option. It is best to select the recording dimension and then select the Lock to application option.
Camera and Audio Options
Select the Webcam icon if you have a web cam on your computer. The webcam can be set up to record the instructor while recording/discussing the lesson being recorded on the screen.

If you have a microphone hooked up to your computer, the Audio selection is on by default. Select the Audio drop-down menu to select the appropriate audio device being used for your recording if you have more than one connected to your computer. If you see this option as Off, click on the dropdown to make sure you select the correct device.

Since you are wanting to capture your voice when recording the screen, you will want to make sure the audio quality is good before you start recording. The audio level to the right of the Audio icon will help you decipher how well you voice is being picked up. You can adjust the rate at which your voice is picked up by moving the slider to the right or to the left. You want the input to be in the middle or the audio level icon, in the green to yellow color.

You can also click on the dropdown next to Audio and select options to adjust the volume control as well as change the audio output.

Tip: You may want to do a quick 5-15 second recording to verify your audio is picking up as you expect. Similar to how a musician would check their mics before a concert. Check, Check, Check, One, Two...

If you like your screen capture and dislike your audio, you can always keep the video, silence the audio, and re-record the audio over the video. We will cover this later in this course.
**Start a Recording**

When you have your screen dimensions and your microphone audio set, you are ready to record. To start your recording, click on the Record the screen button located on the top left side of the screen.

Before you start recording, here are a couple shortcuts that are handy to know.

**Recording Shortcuts**

- **F9** – Pauses the recording. When you pause the recording, Camtasia will remember where you mouse was and will replace it to that location when you restart your recording.
- **F10** – Stops recording.

To start a recording, click on the red Rec button.

After you click on the Rec button, a three second count down will. When the recording starts, narrate and navigate the application tools for the video.

When you have finished your recording, click on the Stop button, or press the F10 key.
The screen capture will stop and the captured video will display and play in the Preview window.

**Save and Edit the Video**

- Select the “Save and Edit” button if you want to Save and Edit the video clip.
- Select the “Delete” button if you want to delete the video clip.
- Select the “Produce” button if you have no edits and wish to produce the video for distribution.

Make sure to provide a unique name for the video and store it in the appropriate location on your computer or network.

At this point, the video is saved on your computer as a .trec file. The .trec file can be used multiple times by importing it into a Project.

Think of the .trec file as the original source, or the raw footage of your video and audio.
The .trec will automatically open in Camtasia Studio after you save the file. Camtasia will ask about the sizing of the video for editing. The video can stay in the same dimension that it was recorded as, or it can be changed here. The Editing Settings are tied to the output file type you plan to use in order to share your video with others. Click on the Preset drop-down menu for a list of options.

**Tip:** Make sure the “Keep aspect ratio” checkbox is checked.

**Project (camproj) versus Recording (trec) Files**

The recording file is the video file, whereas the project is all of the media in the Clip Bin, clips, effects on the timeline, any editing completed on the timeline and the editing dimensions. Each recording file can be used in multiple Projects. A project can contain many recording files. A Project is the work in progress and the final product of your video.

**Tip:** Save your Project file and Recording File in the same location.

**Save the Project**

After you have opened your .trec file in Camtasia Studio, any changes that have been made will be made to the Project. Remember, the recording is just the audio and video that you recorded. The entire finished video is what Camtasia calls the Project. You will have to save your project before continuing on. If you do not save your project, you will have to start over from your original recording.

To save your project, go to the File menu, Save project as. Navigate to the folder where you want your project, give it a unique name, and click Save.

**Open an existing Project**

There are a couple ways to open and existing project. One way is to select a Recent Project from the splash screen when you first open Camtasia.

If you are in Camtasia, you can click on “File” then select “Open project...” browse to the folder containing the project and double click on it or select the project and click on the “Open” button.
Camtasia Studio

After the recording is saved and your editing dimensions have been selected, Camtasia Studio opens and your recording is automatically added to the Timeline and inserted into the Preview Window.

Play the video in the Preview window by selecting the Play button, which is located below the video, or by hitting the spacebar.

After you have saved the video recording, you will want to save the Camtasia Project. To do this, click on File, Save Project As, provide a unique file name.
**Tools Options Menu**

The Tools, Options menu holds all of the default settings for the duration of transitions, images, callouts, title clips that are added to a video, as well as a few other settings that are worth taking a quick look at before recording a video. To view the setting, click on the Tools Menu and then choose Options, which is located on the bottom of the menu.

All of the duration settings are located on the lower right side of the Options window. Any of these settings can be changed at any time, but it is best to set the options before adding in transitions, callouts, etc. By doing this first, the settings will be set when additions are added into a video. Even though a default duration is set, each addition to a video can be changed individually as they are added.

One setting to look at is the SmartFocus option. These are auto focuses to your screen that Camtasia automatically puts into your recording. Sometimes these smart focuses are accurate, but most of the time, the focuses don’t zoom into the correct spot, or they don’t zoom out enough. SmartFocus only works when you are recording in full screen mode.

**Delete SmartFocuses**

If you do have SmartFocuses on your video, make sure you preview your video to make sure these focuses display correctly.

If you would like to delete an individual AutoFocus, click on the AutoFocus icon within your timeline and hit the delete key. To delete all of the animations on your timeline, right click on the animations on the track and select.
Camtasia Timeline
The Timeline is used to assemble and edit the video. The timeline is broken up into various tracks.

Tracks
A track is the sequence of clips and elements (callouts, cursor, zoom) that are included in a video.

To add a new track, click on the Tracks button on the timeline toolbar and select the track that you would like to include on your timeline.

Tip: If you recorded voice with your video, audio and the video will be placed in the same track. If you want to play music in the background, you may add a new Track.

By default, when you make a recording with audio and video, those two pieces will be placed together on the same track, Track 1. If you need to edit either of these pieces separately, you will want to separate the video and audio. To do this, right click on the track containing the audio and video and then select Separate video and audio.

Make Selections on the track
To make a selection on the timeline to apply edits, you need to click on the location that you want to edit with the playhead. The play head consists of 3 parts, the green In Point, the red Out Point and the gray Playhead. Click and drag the in and/or out points to make the selection. The Zoom Tool can be helpful in this situation to get a more accurate selection. The selected area is highlighted in blue.

Tip: To play just the selected area on the track, press the spacebar. To reset your selected area, double-click on the playhead.
Zoom Tools
The Zoom Tools will allow zoom in and out on the actual timeline so more detailed work can be done on the timeline.

Editing Tools

Cut
A cut removes a selection from the timeline and puts it on the clipboard. The selection may be pasted back onto the timeline. You can cut with a single clip or across multiple clips. This is also the easiest way to delete a part of your audio/video from your timeline since after you have cut out a section, the remaining sections will be butted up against each other. If you use the delete key, you will have a space where you deleted from the timeline.

Copy
A copy makes an exact copy of a selection from the timeline and puts it on the clipboard. The selection may be pasted back onto the timeline.

Paste
Paste will insert either a cut or copied selection of the timeline back onto the timeline. To insert a pasted selection, you must move the playhead to the new location and click the paste button.

Split
The Split tool divides one clip into two clips. You can move and edit each clip separately. Splits are used when you want to insert transitions, title slides or graphics between scenes.

Voice Narration
Camtasia Studio will allow the recording of a voice narration as a standalone file that can then be added to your project.

To add a voice narration over a screen capture, place the playhead at the point to add in audio within the timeline. When the playhead is in the correct location, click on the Voice Narration icon which is located in the Task Tabs, below the clip bin.

The Voice narration options will open to the left of the preview window.

Before starting the recording, select the checkbox for Mute speakers to block out sounds that might come from the computer while recording, such as a new email notification, or any other audio that may be a part of the timeline. It is also best to test the input level by talking into the microphone to verify the audio settings aren’t too high. Typically, if the audio level is in the green to yellow area, the audio should be fine. If the audio levels are too low, meaning the graph is green, click, hold, and drag the level towards the High area under the input level.
Once all the options have been selected, press the Start Recording button. Your video will start to play and you can add the audio to the video.

When finished recording, select the Stop Recording button. Camtasia will prompt you to save the audio file as a .wav file. Provide a unique name and Save the file. It is best practice to save the file in the same location that the project is saved in.

After the audio has been saved, it will be added to the timeline. Play your video to see if your audio and video are in sync. If you do have two Audio files, they will both play at the same time.

**Zoom-n-Pan**
Sometimes zooming in on a section of your video is important in order to bring more emphasis to the specific topic.

Position the playhead in the timeline where you want to add the Zoom. In the Task tabs, under the preview window, click on the Zoom-n-Pan icon. The Zoom-n-pan preview will appear to the left of the video preview. From the Zoom-n-Pan preview, click hold, and drag any of the placeholders around the screen to zoom the video onto a specific area of the video. To move the zoom, position the cursor within the zoomed in area to click, hold and drag the zoom to another portion of the recording. Under the zoom preview there is a Maintain aspect ratio. It is best to have this option selected as this will enable the screen to keep its proportion, as the recording is zoomed in or out.
Any time a Zoom is added to a recording, another Zoom must be added to get the screen back to the original size. If you do not do this, the screen will be zoomed in for the entire video. To get your video to a full size again, move your playhead to the point where you want to go back to full screen, then click on the Fit entire Canvas button.

Once you have added the zoom to the video clip, you will see this icon on the Video track. It isn’t crucial to get the zoom point in the exact location at first, because you are able to move it. To move a zoom point, click on the zoom icon and drag it to a new location on the timeline.

The tail on the arrow is the amount of time it takes for the screen to zoom. The circle on the right is when the full zoom takes effect. If you click on the icon, you will be able to lengthen or shorten the duration of the zoom by dragging the tail one direction or the other.

To zoom in on your timeline, you may need to zoom in by using the Zoom tool to do this. The Zoom tool is located above the tracks on the left side of the screen.

Delete a Zoom-n-Pan
To delete a zoom point, clicking on the zoom icon so it is highlighted in yellow and then pressing the Delete key.

Callouts
Callouts are graphics that appear on top of a video to draw attention to important objects or processes in a video. To access the Callout feature, click on the Callout tab on the Task Tabs list.

Add a callout to your video by positioning your playhead where you would like your callout to be. Navigate to the Callouts tab and select the shape of callout that you would like on your video from the dropdown menu.
When you select the shape you want to use, it will appear in the preview screen. You are able to click, hold, and drag this shape to a location on the screen where it is most effective. You will also have the options to change properties of the callout; change color, add text, adjust the fade in and fade out time.

**Review a Callout on the Timeline**

The shaded area before and after the callout on the timeline is the fade in/fade out duration. The actual size of the callout on the timeline is tied to the overall duration of the callout in the video segment.
Test the callout by moving the playhead to the left of the callout on the timeline and preview the video by pressing the spacebar. If you need to adjust the length of time the actual callout is displayed in the video, resize the callout on the timeline by moving your cursor to the right edge of the callout until your cursor turns into a horizontal line with two arrows. When your cursor has changed, click, hold, and drag the right edge of the callout to the right until you have reached the desired time for your callout.

You may also type in a time by right clicking on the callout and selecting “Duration…” A window will populate where you will be able to enter in the amount of time in seconds that you would like the callout to appear for. When you have entered in the time, hit OK.

Tip: Click on the callout on the timeline to display the properties to adjust Fade in, Fade out, or change colors.

Animated Callouts
You may also create animated callouts within your video. Animated callouts can drop in from outside your video, then spin and move to point out another area of the video.

To make your animation fly-in to your video, first select your callout on the timeline and move the callout outside of your video in the preview window. Click on the Visual Properties tab and click on Add animation. Now, click and hold on your callout and drag it to the location where you want the callout to display.

Your animation will appear on your callout as a dot with an arrow leading up to it. The longer the tail of the arrow is, the longer the animation will take to finish. You can adjust the length of the animation by clicking on the tail and dragging the icon.

To edit the animation, double-click on the animation icon on the timeline and you are able to change the function of the animation.

Note: The Visual Properties option can be used an any item added onto your timeline; Zoom, Callout, Pictures, etc.
Group Items on Track

Items can be grouped together in order to help keep your timeline organized, to keep certain callouts together with your video, or if you would like to move all media together. To Groups all items on a Track, right click on the Track name, then click on Select all media on track. When all of the items are selected, right click on one of the items and select Group. Ctrl-G is the shortcut.

All of your tracks will now be included in the group. You are able to edit each piece if necessary by clicking on the + sigh next to the group name.

Cursor Effects

Cursor effects will highlight your cursor in the video. These can be helpful for drawing attention to something that has to be clicked or you want to bring attention to something you want the viewer to notice.

Note: Camtasia has a current bug with Cursor effects and Groups. Cursor effects can only be added to .trec clips, and not to a group, even if that group contains a .trec file. If your .trec file is included in a group, you will have to expand the group, and then select the .trec file in order to add a cursor effect to the video.

To access the Cursor effects, select the Cursor effects tab from the Task Tabs list.

To add a cursor effect, move the gray playhead to the position where you want to highlight the cursor. With the playhead in place, click the Add animation button.

Once the cursor effect has been added, then the settings for the cursor can be added.

Tip: When a cursor effect is added, you must add a new cursor effect to bring the cursor back to its default setting.

When the cursor effect is added, you will be able to move the cursor on the timeline as well as adjust the fade in effect of the cursor by dragging the tail of the cursor effect on the timeling.
Add Captions to a Video

In order to comply with the 508 Disability act, one should add captions to all videos created. Captioning is basically a written script that you add to your video.

When adding captioning to a video, a point to remember is that Camtasia can only display three lines of text at a time in the captioning display.

To add captions, click on the Captions tab on the Task tab list. It may be under the More tab if you do not see it.

There are four ways to add captions to your video

- **Add captions using the speech-to-text feature**
  Create captions based on the audio on the timeline. This will use Microsoft’s Speech-to-text feature

- **Add captions manually**
  Type each caption into the text boxes. You are able to set caption points to determine where the caption should begin and end

- **Add captions by synchronizing text with audio**
  Paste a prepared script into the text box and synchronize the captioning with the audio playback

- **Import a prepared caption file**
  Import an SRT, or SMI file into Camtasia to automatically sync the captions to the video

When you have put all of your captions in the text boxes, click on the “Sync captions…” button. This will play your video and allow you to click on the text you want to appear on the screen to sync up with your video.

The captions will appear on the timeline and can be adjusted by selecting the caption and dragging it to another location and they may also be adjusted in length by selecting either the left or right edges and dragging.
Add a Title Slide

One way to add a title slide is to use PowerPoint. There are certain dimensions to use based on the final size of your video so the Title Slide fits the video correctly. The chart to the right will help you with this.

When you have produced your Title Slide in PowerPoint, save this file in the same location as your Camtasia project so you can find it easily. In order to import this file into Camtasia, you will have to save it as a .jpeg file. I recommend saving the file as both a PowerPoint (.pptx) file and a .jpeg file because if you ever have to make changes, you are only able to do so on the .pptx file.

To save the slide as a jpeg in PowerPoint, click on the File Tab and Select Save As

When the Save As Window appears, select “JPEG File Interchange Format” from the “Save as Type” dropdown menu, then click on the “Save” button.

Once you have saved your .jpeg image, you will have to import it into Camtasia. To do this, while in Camtasia, click on file and select “Import media...”
Add items to the Clip Bin

Any file, picture, video, that you would like to add to your timeline, has to first be added to the Clip Bin within Camtasia. To add items into the clip bin, click on the Import media icon on the top of the Camtasia screen.

Navigate to the folder containing the file(s). Select the files and click on Open.

The files are now added into the Clip Bin, along with any other files, including the .trec file.
Add Files to the Timeline
The Timeline is located at the base of the Camtasia window. The Timeline is where the images, audio and video get blended together in order to complete the video. When importing a file, you will need to Add the file to the Timeline in order to make further edits.

To add an item to the Timeline, navigate the playhead to the location on the timeline where you would like to add the file. Right click on the item and select “Add to timeline at Playhead”

The file will be placed on the timeline in the location of the playhead.

When the file is on the timeline, you are able to move the file to a new location, edit the amount of time the file is on the timeline, add transitions, etc.

Add Transitions
Transitions will add a visual effect between different items on your Video section of the timeline. To access this option, select the Transitions tab from the Task Tab. If you double click on any of the Transitions icons, a preview will show in the preview window. When you have found the transition that you want to use, left click and hold that transition and drag it to the track where you want the transition to go. You can put it at the beginning or at the end of the Track.
Produce
Once you create your video and make the necessary edits, it’s time to produce and create an output file for sharing.

From the File menu, select “Produce and Share”

The Production Wizard dialog box will launch giving you an option to edit the output settings that were chosen earlier, prior to recording. If you are producing this for a specific format, it is best to choose that format from the dropdown menu. If you want to customize the final product, adding a watermark, select “Custom production settings” from the dropdown menu.
The next page will give you options for the format of your video. You can select from the options, or go with the Recommended setting which is a Flash / HTML5 format, and then click Next.

You will also have the options to change the look of display that the video appears on.

- **Controller**: displays play, pause, stop, volume
- **Size**: What size do you want your video to be. It is best practice to keep this the same as your editing dimensions
- **Options**: If you have used Captions, always check to make sure Captions is checked.

Click next when you have finished with your selections.
The next page will give you a couple more options, one which we are going to look at, being the Watermark. You are able to add a watermark that will display throughout the entire video if you would like. To add a watermark, click on the options button under the Watermark heading.

The Watermark window will allow you to browse to the location of the file that you want to use. There are also options on the location of the watermark, effects of the image, and scaling. A preview will also appear so you can see what the watermark will look like on your video.
**Production Name**

The second part of the Production Wizard will allow you to type in a Production Name and select a folder for the storage.

After you have set the name and picked the folder for the video to save in, click Finish.

When the production has been rendered, you may select the Open production folder button to view your video.
Record PowerPoint with the Camtasia Add-In

When you install Camtasia, you will be given the option to add in the PowerPoint Add-in. If you do this, you will be able to record your PowerPoint presentations within Camtasia as well as add in any callouts, zooms, captions, etc to your video, just as you would with a normal Camtasia video.

To use this feature, open PowerPoint and navigate to the Add-Ins tab.

Located in the upper left side of the PowerPoint window, you should see the recording toolbox. To start your presentation and record it, click on the record icon. This will full screen your presentation and start the Camtasia Add-in, which will be located on the bottom right of the screen.

**Note:** The recording will not start until you click on the begin recording button.

Once you click on the record button, you will navigate through your slideshow just are you were presenting it. Any transitions, animations, etc. that you have added into your slideshow will be recorded as well. When you have finished recording, click the Esc key to stop.

When you hit Esc, or you reach the end of your presentation, Camtasia will ask if you would like to Stop the recording or Continue. If you would like to record something else along with your presentation, you are able to click Continue and Camtasia will continue recording your screen. If you are finished with your video, click Stop recording.

You will now be asked to save your .trec file. Type in the name of your new file and click Save.
After you have saved your file, you will be asked if you would like to Produce your recording, or if you would like to Edit it. If you are satisfied with the recording, click Produce, and Camtasia will produce your recording into a format that you be able to share with others.

If more editing is needed to be done to the recording, click on Edit your recording and select OK.

The file will be reopened in Camtasia, where you will be able to add in callouts, cursor effects, etc.